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Preface

Agile PLM is a comprehensive enterprise PLM solution for managing your product
value chain.

Audience

This document is intended for administrators and users of the Agile PLM products.

Documentation Accessibility

For information about Oracle's commitment to accessibility, visit the Oracle
Accessibility Program website at
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.

Access to Oracle Support

Oracle customers that have purchased support have access to electronic support
through My Oracle Support. For information, visit
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing
impaired.

Related Documents

Oracle's Agile PLM documentation set includes Adobe® Acrobat PDF files. The Oracle
Technology Network (OTN) Web site
http://www.oracle.com/technetwork/documentation/agile-085940.html contains
the latest versions of the Agile PLM PDF files. You can view or download these
manuals from the Web site, or you can ask your Agile administrator if there is an Agile
PLM Documentation folder available on your network from which you can access the
Agile PLM documentation (PDF) files.

Conventions
The following text conventions are used in this document:
Convention Meaning
boldface Boldface type indicates graphical user interface elements associated

with an action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for
which you supply particular values.
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Convention

Meaning

monospace

Monospace type indicates commands within a paragraph, URLs, code
in examples, text that appears on the screen, or text that you enter.
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Introduction to Agile PG&C

Agile Product Governance & Compliance (PG&C) is designed to help manufacturers
manage all kinds of product compliance, including the ability to audit the presence
and amount of regulated substances used in their products, and to demonstrate that
they responsibly dispose of, recycle, or re-use parts containing those substances.

Compliance Regulations

OEM manufacturers are required to take global responsibility to dispose of, recycle, or
re-use electronics that contain hazardous substances. In addition to satisfying FDA
regulations and ISO standards, any company that sells electronics equipment in an
international market is subject to the OEM manufacturing regulations of their target
markets. These may include one or more of the following:

s United States: Good Manufacturing Practices; ISO Standards; U.S. Food & Drug
Administration regulations

s Europe: Good Manufacturing Practices; Registration, Evaluation, Authorization
and Restriction of Chemical Substances (REACH); Restriction of Hazardous
Substances (RoHS); Waste of Electrical and Electronic Equipment (WEEE)

s China: Restriction of Hazardous Substances (China RoHS); Waste of Electrical and
Electronic Equipment (China WEEE)

= Japan: Japanese Green Procurement Survey Standardization Initiative (JGPSSI)

= International: Joint Industry Guide (standards adopted by international
companies, including IBM, Dell, Hewlett-Packard, others)

Cycle of Compliance Data-Gathering and Corrective Action

This figure depicts a process of due diligence concerning the compliance of existing
products and new product designs. This is a “closed-loop” compliance corrective
action process. Other Agile solutions - Product Collaboration, Product Quality
Management, Product Cost Management, Product Portfolio Management - manage
areas around the lower half of the circle. Product Governance & Compliance manages
the compliance data-gathering area.
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How PG&C Helps You Gather and Manage Compliance Data

Compliance Data Gathering a g

Managed by PGEC S,
4 Declarations

=

Componént

Froduct design and
procurement

Managed by other
Agile solutions

How PG&C Helps You Gather and Manage Compliance Data

People who manage the compliance process at the “buyer” site - compliance managers
- must ensure that their company's products adhere to government regulations and
company policy. Agile PG&C helps you gather and analyze compliance data and to
take appropriate corrective action.

PG&C is not only a communication vehicle between the compliance manager and
information suppliers: it also manages the compliance of parts across multiple
suppliers and multiple manufacturer parts.

Ultimately, PG&C rolls all this information up to provide a product-level view of
compliance.

More specifically, compliance managers use PG&C to:
s Collect data about materials used to manufacture a product

= Review compliance across the Approved Manufacturers List (AML) of a part,
across multiple suppliers (the Approved Suppliers List, or ASL), across BOMs,
subassemblies, and of final products

= Generate reports to show the level of compliance

= Manage supporting documentation, such as descriptions of current regulations,
recovery manifests, disposal certificates of destruction, supplier compliance
surveys, and other customer-specific specifications.

Compliance managers often get compliance information for manufacturer parts from
an information provider or collect the information via IPC standard /Excel spreadsheet
and then load the collected compliance data into a PG&C declaration. Often this
process gets automated via Customizations/Process Extensions.

In another scenario, at the supplier site, information suppliers use PG&C to complete
and sign off material declarations:

s Declare compliance with specifications concerning hazardous materials that may
originate from its customers and from government agencies

= Disclose which hazardous substances are contained in the components and
subassemblies it provides.

1-2 Agile Product Lifecycle Management Product Governance and Compliance Supplier Guide
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Agile PLM Documentation for PG&C

The Preface of this manual provides the URL to Agile documentation for current
releases of Agile PLM.

This manual, Agile PLM PG&C Supplier Guide, provides information for you to learn to
work in Agile Web Client and to complete your end of the compliance process.

A supplier in the PG&C solution is a company that provides compliance information
about parts that are used in a buyer company's manufacturing process. The Agile
administrator at the buyer company has created Agile users, which have been called
“contact users” and are now referred to as “declaration recipients” in the PG&C
framework.

The compliance manager at the buyer company creates declarations that are sent to the
supplier's declaration recipients. In turn, declaration recipients complete declaration
requests from the buyer.

The Agile PLM PG&C User Guide is the manual for working in the PG&C solution on
the buyer side. It describes the PG&C-specific business classes in depth, as well as
compliance rollups and other features. In some cases, the manager of Agile-based
compliance work at your firm might find value referring to it.
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RFI Process and Agile Classes

This manual is the handbook for suppliers and buyers seeking compliance information
via Agile PG&C.

Your company may or may not actually manufacture specific parts that go into the
products of an OEM; in any case, your company does provide compliance information
about parts to this manufacturer.

Requests For Information

RFI Sequence

At the supplier site, information providers use PG&C to complete and sign off on
Declarations - the vehicle of Requests For Information (RFIs):

s Declare compliance with specifications concerning hazardous materials;

= Disclose which hazardous substances are contained in the components and
subassemblies it provides or is authorized to provide data or other disclosure
information.

The general sequence of the RFI process follows. The supplier is involved in step 5
only; the other steps take place at the buyer company.

1. Identify parts and part groups for which compliance data is required.

2. Identify people within buyer company and suppliers (for manufacturer parts) who
can provide compliance data.

Create declarations for parts, manufacturer parts, and part groups.
Route a declaration to an information supplier.
Supplier completes the declaration with data and a sign-off.

Compliance data is assessed for completeness and validated for correctness.

N o a 0

Reviewed and approved declarations are released, which “publishes” the data
across the product record in PLM.

The RFI process is depicted below.
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A declaration keeps track of the compliance information about substances and
materials contained in parts or part groups that are named in the declaration. The
Default Declaration Workflow conveys RFIs from your buyers. Agile PLM also makes
it possible to send customized Declaration workflows to suppliers.

PG&C Business Objects

Substances

The PG&C solution offers configurable business objects called Substances,
Specifications, Declarations, and Part Groups. Items and Manufacturer Parts (from
Agile Product Collaboration) are also integral to the solution.

Note: Itis possible that your buyer's Agile administrator has
renamed existing classes and created new subclasses than those
presented in this guide.

Here are brief definitions of the PG&C business objects.

Substances are basic building blocks in PG&C. A substance is any chemical element or
compound that is tracked within Agile PLM. There are four kinds of substances, which
cover a variety of circumstances: Substances, Substance Groups, Materials, and
Subparts.

= Subparts class - a subpart is a subunit of a component. Subparts are not numbered
and do not expand the BOM.

= Materials class - a material is a compound chemical, that is, a substance consisting

of multiple substances. A good example of a material is a glue or a resin that can
be bought in bulk.

= Substance Groups class - a group of multiple substances. A substance group must
have a Base Substance, which is the substance that the legislation is interested in.
A substance group called "Lead and Lead Compounds" would cite Lead as its base
substance, and it could comprise chemicals like Lead-oxide, Lead-nitrate, and
Lead-sulfate.
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= Substances class - a substance is a single chemical element; for example, lead,
chromium, or cadmium. Generally, these are the potentially hazardous substances
that legislations are interested in, as described in specifications. The new Alias
attribute facilitates possible inconsistencies in how substances are named by the
supplier.

Substance Aliasing

The Alias attribute is provided to inform the PG&C system of "substitute names" of
substances and substance groups. For example, an alias for Lead could be the chemical
notation "Pb". The buyer's system can then resolve confusion if you, the supplier,
submit information for a substance that you call Pb but they call Lead.

If the name of a substance/substance group that you provide (in the declaration) does
not exist in the buyer's system (and it is not already an alias for another substance), the
buyer can add it as an alias for the intended substance/SG.

This makes it easier for you to use names of substances and substance groups in your
declaration responses according to your conventions without concern that a name may
be different in the buyer's system.

Specifications

Specifications track the different legislations, customer specifications, or internal
specifications with which an assembly or part must comply. The Specifications object
is used to create representations of specification documents, regulations, published
compliance criteria.

An example of a regulation issued by a government body is the European RoHS
directive. Environmental specifications are substance-based, and contain a list of
banned substances or substances of concern and their threshold values.

In Agile, specifications are used to validate declarations and assess the compliance of
parts by evaluating whether a given restricted substance in the composition of a part
surpasses its specified threshold value.

Parts and Part Groups

Items and Manufacturer Parts can be referred to generally as “parts.” The phrase
“parts and part groups” (or the notation <Part/PG>) comprises “any kind of part used
in the buyer company's manufacturing process.”

Items and Manufacturer Parts

Items (Parts and Documents) and Manufacturer Parts - we refer to these collectively
as "parts" - are two base classes in Agile PLM that are used to create objects that
represent the things that your company and its suppliers assemble into the products
your company sells. They are therefore the entities for which compliance data must be
sought.

Part Groups

A part group (PG) is a “container” that tracks the overall chemical composition for all
parts of a particular type. If multiple parts share the same properties - for example, the
same composition - you can define a part group with those characteristics. The parts
(items and manufacturer parts) belonging to a part group have a conversion factor that
is used to convert data such as Mass and Substances Content from the part group to its
member parts.
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To describe how the conversion factor works, let a part group describe a series of cable,
made of the same materials and available from supplier(s) in a variety of lengths. The
part group (the Agile object) contains the data that defines the “unit” length of cable to
be 2 feet long. The part group object then lists cables of 2 ft, 6 ft, and 10 ft in length. So,
the 2-ft cable has a conversion factor of 1 in terms of its mass and hazardous
substances content, the 6-ft cable has a conversion factor of 3, while the 10-ft cable has
a conversion factor of 5.

Declarations

A declaration is the main object of record in the PG&C solution: it stores questions
posed by a compliance manager to an information supplier about the supplier itself,
its products, or how its products comply with given specifications. Upon completion,
it contains the supplier's data and responses to the questions. Also, declarations keep
track of all the substances and materials that are contained in parts or part groups.

PG&C offers an attribute called User-entered CAS Number, which can be entered by
the information supplier on a declaration or by a regular user on a part or part group.
These are used by the compliance manager to ascertain precisely what substance is
being referred to by the supplier.

In Agile PLM, the Declarations base class has seven default classes of declarations,
each with a single child subclass. The following table defines the kinds of declarations
in PG&C.

Declaration class Definition

Substance The supplier is requested to provide compliance information for each
Declarations substance within the specification.

Homogeneous The supplier is requested to provide a complete BOS breakdown of
Material the part and provide compliance information at the homogeneous
Declarations material level.

Part Declarations Receive part-level compliance information as well as other

composition header level information (manufacturing parameters).

JGPSSI Declarations The supplier is requested to provide compliance information
(weights) according to the JGP standard.

Note: There is a fully supported Japanese version of the JGPSSI
template for creating JGPSSI Declarations; see your administrator.

Supplier A questionnaire to assess supplier compliance with specifications

Declarations of from customers and government agencies. The survey addresses

Conformance compliance at a general company level. Can be used for CSR-type
declarations.

IPC 1752-1 A Joint Industry Guide (JIG) substance declaration for electronic

Declarations products.

Note: In addition to the IPC 1752-1 subclass, the IPC 1752A subclass
is available. It represents the latest version of the standard.

IPC 1752-2 A Joint Industry Guide (JIG) homogeneous-material declaration for
Declarations electronic products.

Note: In addition to the IPC 1752-2 subclass, the IPC 1752A subclass
is available. It represents the latest version of the standard.

Declarations are the routable objects in PG&C, similar to change orders in Product
Collaboration. As a routable object, each declaration advances through a workflow
that implements the Request for Information (RFI) business process. When a
declaration is released by the compliance manager, the information gathered from it is
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published to the product record, thereby updating the composition data contained
within the parts and part groups listed by the declaration.
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Using Agile Web Client

Agile Web Client is opened using only a browser. Web Client is the only client that
supports Agile's Product Governance & Compliance solution (PG&C). As a supplier,
you are generally assigned to “Basic mode," and your user interface with Web Client
has been streamlined for responding to PG&C declaration requests.

If your work becomes more involved and the buyer firm assigns you one of the
“Advanced modes,” you can see the user interface of Web Client; in that case you refer
to the standard solution manual, Agile PLM PG&C User Guide.

Logging In to Web Client

Your buyer company's compliance manager has issued you a starting URL, along with
username (User ID) and password. If a URL is specified in the documentation or
release notes, copy the upper- and lower-case characters exactly, including the full
domain name specified.

To start Web Client:
1. Start your browser.

2. Click the Web Client bookmark, if one exists, or type a URL that follows this
pattern:

http:/ / <webserver>.<domainname>.com/Agile/PLMServlet
The Login page appears.
3. Enter your username. Your username is not case-sensitive.

Your username is assigned by your Agile compliance manager; it is likely an
abbreviation of your full name. For example, the name Michael Jones may be
abbreviated to MICHAEL] or MJONES.

4. Enter your password. Your password is case-sensitive.

5. Click the Login button. If you make a mistake, click Clear and retype your
username and password.

The login process is complete, and the Requests for Information page appears. In the
page's title bar you will see "Welcome, <Your Name>".

The page is on the Open Requests link, so the table will list any Agile “declaration
requests” that have been sent to you.

Using Agile Web Client 3-1
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Main Toolbar

You can use the toolbar buttons on the main toolbar to perform the tasks described in

the following table.
Name Description
Back Takes you to the previous page you viewed in your

browser. (It does not, however, undo any changes you
entered in Agile.)

Forward Takes you to the next page forward. It is disabled if
you have not gone forward from the page currently
in your browser.

Refresh You can refresh (update) the information on the
visible page.
Home Brings you back to the basic RFI page.

Find (Run Simple Searches for declarations that match your typed

Search) input. For example, if you are in Open Requests and
there are many, you can search and find the one you
are looking for.

Logging out of Web Client
To log out of Web Client:
1. From the menu bar, click the Logout button.

2. You are returned to the Login page. To exit, close the browser from the upper-right
corner.

Printing Declarations

From the Basic Supplier Interface, the system will print the following tabs of a
declaration: Cover Page; PageTwo; PageThree; Parts/Part Groups tabs as well as the
corresponding Substances tables; and Specifications.

Left Pane Links - The left pane on the main RFI page has links as follows:

Open Requests - this is the default link so you generally see a list of all your open
declaration requests. If you have clicked another link, Open Requests appears as a live
link.

s Due Today - lists all open declarations whose due date is set for the current
calendar day.

s Due Tomorrow - lists all open declarations whose due date is set for the next
calendar day.

= Delinquent - lists all open declarations whose due date is set for the previous
calendar day or earlier.

= Inactive Requests - lists all declarations that were submitted to you but that have
been closed by your buyer.

Open Declaration Links

When you have opened a declaration request, the left pane changes its links to the
following:
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= Edit - Click this link to activate editable fields. Change or add values in any of
those fields. Click Save to preserve your changes, or click Cancel to end the
operation with no changes saved.

= Add Attachments or View Attachments - Click this link to add attachments to the
declaration (for example, you may want to return a spreadsheet file to the buyer).
If the declaration already has attachments, the link says View Attachments, but
you can still add attachments by clicking and following the user interface.

= Submit Declaration - When you have completed providing the requested data on
the declaration-and signed off-clicking this link will send it back to the compliance
manager at the buyer firm.

s Print - You may wish to have or distribute a hardcopy of the declaration at the
start or when it is completed. Click this link to bring up a Print dialog.

= Email Comments - You may have a question for the compliance manager or other
information that you want to quickly distribute. When you click this link, there are
two elements to complete. In the Comments field, simply type your message or
question. Click the Send To button to start a wizard to find names.

When you are ready, click the icon to send the comments.

Note that following the actions listed above, other applicable process extensions are
displayed.

Changing Your User Profile

Your User Profile is simply the collection of settings that were entered by the Agile
administrator when your “user object” was created. Clicking the link in the main
toolbar displays the information contained in your profile, some of which is simply
information (like phone number) and some of which governs your access to Agile
declarations (like Role).

Your user profile is available for you to modify, within constraints set by the
administrator. It contains data under two tabs, General Info or Preferences.

Important: Under Preferences, the Response Edit Mode property is
must be set to Basic.

If you select one of the other two settings, Advanced Table Edit or Advanced Wizard
Edit, when you click Save, you will be prompted to log out and log back in; you
would then log in to Web Client (Advanced mode), where your capabilities are
restricted.

If you do log in to Web Client (Advanced mode), you will have to click the My User
Profile link and go to Response Edit Mode property to change it back to Basic,
followed by logging out and logging back in to Web Client (Basic mode).

If you work frequently with buyer companies and are often required to create
declarations, you can be assigned additional roles and privileges to enable you to work
effectively in Web Client (Advanced mode).

You have an opportunity to enter information when you first log in to Web Client.
Again, your Agile administrator determines to what extent you can edit your user
profile.

To edit or add information to your user profile:

1. Open your user profile by clicking My Profile.
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2. Click the tab on which you want to make changes. For instance, to make changes
to the General Info tab, click that tab.

3. Click the Edit button on that page. Use lists, browse buttons, and text boxes to
enter the requested information.

4. When you have finished, click Save. If you wish to cancel your changes, click
Cancel. Clicking the other tab (General Info or Preferences) cancels the current
Edit operation without saving changes.

5. To verify changes you make to your user profile, it is best to log out of Web Client
and log back in.

Note: If you are working primarily in Web Client, check this setting
in your user profile: Preferences > System Preferences > Preferred
Client; it should be set to Web Client. Also, Receive Email
Notifications should be set to Yes. This ensures that you will receive
email notifications in the same client you are working in. If there is a
discrepancy and you are not able to change these properties, see your
Agile administrator.

User Properties Defined

The following table lists and describes the properties common to supplier users in the
Agile PLM system:

Property Description

User ID (username)  The user's Agile PLM login user identification, or username. It
must be unique in the Agile PLM address book. The maximum is
128 characters.

First Name and Last The user's public name. Neither of the user's Names fields has to be
Name unique in the system, only the user's User ID must be unique.

Status Indicates whether the user is enabled (Active) or disabled
(Inactive). Not editable.

Email The user's valid email address for change notification/routing.
Note: If there is not a valid email address in the Email field, the
user will not receive any email notifications.

Title The user's title, for example, Senior Engineer.

Address fields There are four address fields that are used for informational
purposes only: Address (street), City, and Postal/Zip Code.

Phone number fields The user's Business Phone and Mobile Phone numbers (for
informational purposes only).

Fax The user's fax number (for informational purposes only).
Pager The user's pager number (for informational purposes only).
Secondary Email The user's valid email address for change notification/routing. The

Secondary Email is optional, but when the field is filled in, the user
receives notifications at both email addresses.

General Infotab, The user's role assignments. This property determines a user's

continued access to the objects in Agile PLM from the point of discovery
forward.

Role(s) Power, Concurrent, or Restricted: you as a supplier are a Restricted
user.
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Property

Description

Use Login Password
forApproval

Allow Escalation
Designation
Approval

Sites

Preferred File
Manager

Receive
EmailNotification

Language
Preferred Date
Format

Time Zone

Preferred Time
Format

Preferred Currency

Number Format

Preferred Inbox
View

Response Edit Mode

Rows per Table
Display

Static Table Headers

Encode Type

Each user has a login password and approval password (used to
approve changes).

This setting is editable. If the user has identified one or more
designated escalation persons (DEPs), this setting determines when
the DEPs can approve or reject a declaration. Settings: After
Escalation - The user's DEP can approve a routable object only after
it has been escalated. Always - The user's DEP can always approve
or reject a routable object.

Sites are used for distributed manufacturing, but as sites are not
supported by PG&C, this is unlikely to have options.

Select from the list of file servers. For best performance, select a file
server that is local server for you.

Controls whether the user can receive automatically generated
email notifications from the system.Settings = Yes or No

English is available with all Agile PLM licenses. Agile PLM
includes Japanese or Simplified Chinese, per your license.

The format in which dates are displayed to the user. Default is
MM/dd/yyyy.

The time zone where the user is located.

The format in which times are displayed to the user. The default is
hh:mm:ss aaa (aaa = am or pm).

The currency in which prices/costs are displayed to the user. The
default is U.S. Dollar.

The format in which numbers are displayed to the user.

Select between Activities, Notifications, and Workflow.

This field should be left set to Basic. The other two settings,
Advanced Table Edit and Advanced Wizard Edit, will take you into
the main Web Client, where your capabilities are restricted.

The number of rows that appear in the user's Agile Web Client user
interface. The default is 50.

Set to Yes to carry table headers to additional pages.

The types are Western European (ISO), Japanese (Shift JIS),
Traditional Chinese (Big 5), Japanese (EUC), Simplified Chinese
(GB2312), and Unicode (UTE-8).
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Responding to Agile Compliance RFls

A Request For Information (RFI) is the process that a manufacturing company (the
buyer) uses to seek compliance data from its suppliers. The buyer uses Agile PG&C to
create declarations. When the buyer firm creates a declaration, it specifies a unique
declaration name and a single supplier company.

The Default Declarations workflow follows a straightforward process flow, as detailed

in the following table.
Status Action
Pending Compliance manager (an Agile user who has been assigned the

Compliance Manager role) creates new declaration, or modifies an
existing declaration by adding new items, manufacturer parts, or
commodities. Specifications are added to the declaration, and also an
information supplier; is always only one supplier per declaration.

Open to Supplier The declaration requests the supplier (an Agile user who has been
assigned the Material Provider role) to confirm whether parts comply
with specifications.

Submit to Manager  Supplier confirms or denies that the parts that they supply comply
with regulations.

The supplier electronically “signs” and submits the declaration back
to the compliance manager.

Review The compliance manager and other reviewers verify and approve the
contents of the declaration. A reviewer (including a supplier user)
can acknowledge a declaration when the user is added as an
acknowledger.

Released The compliance manager releases the declaration, thereby publishing
the new data about the substances and materials into the product
record. Once published, the materials are visible on the Compliance
tab of the part or part group, as appropriate.

The “buyer” company can now examine the quantities of all
materials in a given top-level assemblies and find out if the assembly
is compliant with a set of specifications.

Implemented Once the parts are manufactured and disseminated in the field, the
compliance manager implements the declaration, thereby completing
the workflow.

Filling Out a Declaration

To complete and sign off declarations, declaration recipients for the supplier company
have been assigned a role that permits access to the declarations. The default
declaration recipient at the supplier company receives an email of notification.
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All users at the supplier company who have been assigned the appropriate role can
respond to the declaration.

If you have questions about who in your company has been assigned this role, contact
your buyer company.

When you are sent a declaration request, you are responsible for completing it. You
must disclose whether or not any restricted substances are contained in the component
or subassembly it lists, and whether those substances comply with the given
specifications.

Once a declaration is opened to a supplier, only the supplier's declaration recipients
can edit it (that is, Agile users assigned the "(Restricted) Material Provider” role). For
other users, including the compliance manager, the declaration becomes “read-only”
until it is returned by the supplier.

Notifications when Declarations Advance to and from Supplier

This set of default behaviors regards automatic notifications, not user-designated
Approvers and Observers.

s Declaration Buyer to Supplier - The notification is automatically sent to the
supplier. You can add more users to receive notification.

s Declaration Supplier to Buyer - The compliance manager is automatically added
to the notification list. If no compliance manager was selected, the system add
everyone on the Compliance Managers notification list.

= Declaration Supplier to Buyer - If there are no compliance managers in the
system, the originator is added to the notification list.

Acknowledgments

A supplier user can be added as an acknowledger for Declarations. The supplier user
with the (Restricted) Material Provider role includes the Acknowledge privilege. These
terms are described below:

Acknowledge - A workflow action called 'Acknowledge' is available for Review or
Released status.

Acknowledger - A user or user group or job function can be an acknowledger if the
Acknowledge privilege is assigned.

The Acknowledge button is visible for supplier users assigned the (Restricted)
Material Provider role which contains the Acknowledge privilege.

Acknowledgers then use this dialog to notify users of the acknowledgment:
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Receiving Notifications

The Declaration routed for acknowledgment can be seen in Workflow Routings tab,
and can be found in Notifications tab or user's Email box. To see the Workflow
Routings/Notifications tab, the supplier user must be in Advanced Table Edit mode.

The supplier user can receive notifications:
1.  When the supplier user is required to acknowledge a declaration.
2.  When the supplier user no longer is required to acknowledge a declaration.

3. When the supplier user is an acknowledger and the declaration is changed to
another status.

4. When the supplier user is an acknowledger and the declaration is signed off by
other users.

5. When the supplier user is an acknowledger, but does not acknowledge the
declaration in a specific time period.

6. When the supplier user is set as an escalator of an acknowledger, and the
acknowledger did not acknowledge the declaration in a specific time period.

Information Supplier Fills Out a Declaration

When a declaration request is opened to an information supplier, the supplier is
responsible for completing the declaration and disclosing if any restricted substances
are contained in the components and subassemblies it provides and whether those
substances comply with specifications.

To complete and sign off on declarations, one or more declaration recipients for the
information supplier must be assigned the (Restricted) Material Provider role. If you
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have questions about who in your supply chain has been assigned this role, see your
administrator.

When the material provider changes the status of the declaration from Open to
Supplier to Submit to Manager, he must "sign off" the declaration.

Process Sequences in Declaration Fulfillment

The above topic describes how a standard Agile declaration is sent to a supplier and,
upon completion, returned to the buyer. The following process sequences describe a
range of responses to declarations.

1. Declaration Opened and Completed in Agile Web Client

= Supplier firm’s default recipient receives email notification from buyer firm's
Compliance Manager requesting completion of a compliance declaration.

s Click link within notification and log into Agile Web Client (Basic mode).
s Click Open Requests link and select the particular declaration request.

= Fill in your responses directly in Web Client. Currently this is possible only for
Supplier Declarations of Conformance.

s Complete the Sign off Message and submit response back to the Compliance
Manager.

2. Declaration Opened and Completed in Microsoft Excel-based Client

= On the Agile menu in the Microsoft Excel-based Client, select from list of open
declarations. The spreadsheet is populated with data from new declaration.

= Within Microsoft Excel, enter your responses into the form, and save it.
s On the Agile menu in the Excel client, choose Submit Response.
s Complete the Sign-off Message and click OK.

3. Declaration Opened in Web Client and Completed Using Process Extensions

= Supplier firm's default recipient receives email notification from buyer's
Compliance Manager to complete a compliance declaration.

s Click link within notification and log into Agile PLM via Web Client (Basic
mode).

s Use the Export JGPSSI Export AXML, Export IPC 2.0, or Export IPC XML
process extension. The declaration request data is exported in the appropriate
format, and you can open the file.

= Enter your responses into the file, and save it.

s Use Import JGPSSI,Import AXML,Import IPC 2.0 XML, or Import IPC XML
to import the completed declaration data into Agile PLM.

About Declaration Classes and Fields

The Declarations classes in Agile PLM were introduced in Declarations. This topic
describes additional facts and rules of business logic for the Declarations classes.

Part Declarations

This class of declarations is used to ask questions related to parts or part groups. The
buyer company wants to send out a questionnaire to assess part compliance with
specifications from customers and government agencies. Typical questions could be:
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What is the maximum re-flow temperature of this part? What type of plating is on this
part? Is this part in compliance with a certain specification? No fields are
pre-populated in this declaration.

Substance Declarations

This class of declarations allows a supplier to respond at a substance-group level and
at a substance level without being able to add to the Bill Of Substances (BOS). It could
be a material compliance declaration in which the buyer company wants you to
declare compliance with specifications at the substance level; or, it could be a partial
material disclosure declaration in which you are requested to disclose the weight
and/or concentration of selected (or all) substances that are contained within the
components and subassemblies it sources from your firm (or the firm whose products
you are providing compliance information).

A substance declaration supports pre-population of substances and substance groups
from associated specifications.

Supplier Declarations of Conformance

This class of declarations requests statements from suppliers at a supplier level. It is
basically a supplier survey. The buyer company wants to send out a questionnaire and
receive a declaration from the supplier to assess compliance with specifications from
customers and government agencies. Typical questions could be: Do you have a RoHS
compliance Initiative going on? When do you anticipate to have 100% compliant
Product? Which ISO certifications do you possess. No fields are pre-populated in this
declaration. The SDOC does not require association with any items, manufacturer
parts, part groups, or even specifications in order to be effective. Adding specifications
to this type of class is allowed for reference purposes.

Japanese Green Procurement Declarations

This class of declarations is used against the template for the Japanese Green
Procurement format. The Class name in Admin is JGPSSI Declarations. Agile supports
only JGPSSI version 2.02. The buyer company wants suppliers to provide a declaration
in the JGPSSI format using the JGPSSI supported entities. No substances from
specifications are pre-populated in this declaration.

Homogeneous Material Declarations

This class of declarations allows a supplier to build a Bill Of Substances (BOS)
consisting of four levels: subpart, homogeneous material, substance groups, and
substances. It could be a material compliance declaration at the homogeneous material
level, or it could be a partial material disclosure declaration to discover the weight and
concentration of substances that are contained within the homogeneous materials. This
can be effected through an outside application or spreadsheet. No fields are
pre-populated in this declaration.

IPC 1752-1 and IPC 1752-2 Declarations

These two Declarations classes support compliance work using the IPC forms for
substance declarations (IPC 1752-1) and homogeneous materials declarations (IPC
1752-2). These forms are available in XML and Adobe PDF format. Agile PLM 9.3.2
still supports the use of the PDF forms; however the PDF forms are no longer
supported by IPC.

For IPC, we support IPC 175x Version 2.0.
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You must download the Scribal750a_beta06 from
http://sourceforge.net/projects/ipcl75xutils/.

Note: CIPC 1752A represents the latest version of the standard.

IPC Formats Supported in this Release

The present Agile PLM Release supports released Version 2.0 of the IPC format. The
website for the IPC forms and information about the "1752" standards is
http://www.ipc.org/ContentPage.aspx?pageid=Materials-Declaration.

s IPC1752A is supported by XML only; PDF forms are not supported.

s IPC 1752-1 and 1752-2 are supported by XML and PDF forms. Please note that
while you can use PDF forms, they are no longer supported by IPC in version 2.0.

As you create 1752-1 and 1752-2 declarations, you are given the option to choose the
1752A version. We provided two new process extensions to support IPC 1752A
version: Import IPC 2.0 XML and Export IPC2.0 XML. IPC1752-1 and IPC1752-2
declarations can enable the two PXs to implement IPC1752A version. This is described
in detail in the Agile PLM Administrator Guide.

We recommend your administrator create one new subclass of IPC 1752-1 Declarations
and one new subclass of IPC 1752-2 Declarations using Java Client.

PDF forms for pre-version 2.0

IPC declarations prior to version 2.0 use PDF forms. Adobe Acrobat version 7.x is the
minimal requirement, while Acrobat version 8.x is the recommended release for work
with the IPC PDF forms. The website for Adobe Software is www.adobe.com.

The IPC1752-2 PDF form allows entry of unstructured substance data. For instance, the
user can enter homogeneous material data in a hierarchical structure or in a flat
structure. The system also stores the flat structure within the declaration, which can
show the user how the data was retrieved from IPC and how PLM converted the data
into a hierarchical structure.

The storing of the flat structure is accomplished through four flex-fields,
Text01--Text04, on the part Substances tables. They are renamed as IPC Sub-item, IPC
Material, IPC Category, and IPC Substance.

By default, these fields are disabled (not visible), and the flat structure is not stored. In
order to capture the flat structure of the composition, these fields must be enabled by
the administrator. Even with the flexfields enabled, a user must have Modify privilege
for those fields; if not, the flat structure is not stored and the user sees an "Insufficient
Privilege" error during the import procedure.

Guidelines for Parts and Specifications on IPC Declarations

Earlier, each IPC declaration carried just one specification and just one part/part
group. Now Export IPC 2.0 XML and Import IPC 2.0 XML can support multiple
objects.

There is no restriction to the number of specifications or the number of parts/PGs that
can be added to IPC declarations. However, if a declaration carries multiple items,
manufacturer parts, or part groups and multiple specifications, Export IPC 2.0 XML
supports multiple Parts/PGs, indicating that Export IPC 2.0 XML exports all
compositions from the declaration's <Parts/PGs> tables. But Export IPC XML will
only export one composition from the declaration's <Parts/PGs> tables.
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Similarly, Import IPC XML updates only one composition, that of the part that was
exported. The system identifies this by the part number, rev, and the first specification
in the declaration's Specifications table, which is sorted alphabetically.

Import IPC 2.0 XML updates all compositions, that of the parts that were exported.
The system identifies these by the part number, rev, and the related specifications in
the declaration's Specifications table, which are sorted alphabetically. As part of
Import IPC 2.0 XML support of multiple compositions, for one item with different
revisions, the revisions are distinguished by this format: 'Numberld [Rev]".

Significant Attributes in Declarations
The information supplier-user must do the following to complete a declaration.

s For each part, manufacturer part, and part group, fill in the Mass, Mass PPM, and
Compliance fields, particularly for substances that are restricted by specifications

s Add or remove substances from the Substances tables (under the Items,
Manufacturer Parts, and Part Groups tabs) on the declaration as necessary; to do
this, they must use process extensions (Export AXML and Import AXML)

s Complete other flex fields on the <parts/PG> tables as well as the
<parts/PG>Substances tables.

IPC: Resolving ltem Number and Manufacturer Part Number Attributes

If you are having this problem, request from your buyer company that they set a
process extension that can be triggered when moving the declaration to Open to
Supplier. The process extension copies the value from Item Number to Mfr Item
Number, and from Item Name to Mfr Item Name.

You may experience a mapping issue on the pre-2.0 version IPC forms regarding the
attributes Item Number and Manufacturer Part Number (Mfr Item Number), and also
Item Name and Mfr Iltem Name. You may receive a declaration and expect to see (or
want to enter) data in Mfr Item Number and Mfr Item Name. The issue is that the
fields that must be used are [tem Number and Item Name.

This will correct all four fields on the IPC form (after exporting from PLM) to have the
values needed by both the Supplier users (in order to complete the form) and the PLM
system (for importing back to PLM).

Mass

The weight of a part (item or manufacturer part) or assembly, expressed in system
wide UOM (unit of measure). Mass in Item Title Block, is a "rev-controlled" attribute.
Mass Disclosure:

The Mass Disclosure attribute is found on the Part/PG tabs of declarations (as well as
the Composition tab of parts and part groups). It has three values: Fully Disclosed,
Partially Disclosed, and Undisclosed. The correct value is generated by the system
during composition rollups.

Full Disclosure, Partial Disclosure, and No Disclosure

These are the three types of disclosure, and how they are qualified by substance
compositions and homogeneous material compositions.

s Fully Disclosed composition (Full Disclosure):
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1. A Substance composition is considered to be Fully Disclosed if the difference
between the part's mass and the sum of the masses of all the substances is less
than or equal to the Mass Tolerance Percentage setting.

2. A Homogeneous Material composition is Fully Disclosed if this two-step
process is satisfied: (1) The difference between a material's mass (that is, the
immediate parent of the substances) and the sum of mass of the substances
under that material is less than or equal to the Mass Tolerance Percentage
setting; and, (2) The difference between the part's mass and the sum of mass of
the parents of the substances should be within the Mass Tolerance Percentage.

s Partially Disclosed composition (Partial Disclosure):

1. A Substance composition is Partially Disclosed if the difference is more than
the Mass Tolerance Percentage, in which case an "Unreported" substance is
added by the system to fill in the missing mass.

2. A Homogeneous Material composition is Partially Disclosed if one of the
following is true:

3. (1) The difference between a material's mass (that is, the immediate parent of
the substances) and the sum of mass of all the substances under that material
is greater than the Mass Tolerance Percentage setting; and, (2) the difference
between the part's mass and the sum of mass of the parents of the substances
is greater than the Mass Tolerance Percentage setting; or

4. The part's weight is missing, but none of the information is missing in the BOS
tree. That is, the Mass and PPM should not be "null" anywhere in the entire
BOS tree, including subparts, materials, or substances.

s Undisclosed composition (Non Disclosure):

1. If the mass is missing for the part, substance, or the immediate parent of the
substances, it is considered an Undisclosed composition.

Furthermore, a Homogeneous Material composition is Undisclosed if any of
these cases are true:

—  One of the substances in a material does not have Declared Mass and
Declared PPM,; or,

—  One of the materials does not have a Declared Mass; or,
—  One of the materials does not have any substance; or,

—  One of the subparts does not have any child.

User-entered CAS Number

A value can be entered by the information supplier on a declaration or by a regular
user on a part or part group. These are used by the compliance manager to ascertain
precisely what substance is being referred to by the supplier.

Intentionally Added

The "Intentionally Added" property acts as the constraint defined in the Joint Industry
Guide and the IPC 1752 forms. If, for a substance in the specification, Disallow
Intentionally Adding is Yes, when a supplier or other user enters Yes in Intentionally
Added, the substance's Calculated Compliance value is Non-compliant. If that
substance was not intentionally added (= No), the system can go ahead and check the
Threshold PPM of the substance-for-the-spec.
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The compliance manager can modify Int. Added in the Pending status of the Default
Declarations Workflow. The supplier can modify it in the Open to Supplier status of
the same workflow. It cannot be modified in any other status (without administrator
impact). If there is no value in Intentionally Added field, the system assumes No when
performing rollup calculations.

Specification

The compliance manager may inform the supplier that the buyer is going to validate
the supplier's substances based on the specifications on the Specifications tab. If there
are one or more specifications associated with this Substance Declaration (this <type>
only), the system automatically prepopulates the substances from those specifications
for all the items, manufacturer parts, or part groups in this declaration. If there is no
specification associated with this declaration, no substance is prepopulated, even for
the substance declaration.

The specifications may concern many substances, including those not used by the
parts contained in the declaration. When a substance declaration is opened to the
supplier, any substances from the specifications are automatically added to the
Substances for <Part/PG> tables. This ensures that you are properly tracking any
restricted substances contained in parts listed in the substance declaration.

Specification Intentionally Added

In parts/part groups and declarations, the Substances tables also have an attribute
called Spec Intentionally Added. This property points to, on the substance's
Specifications > Substances tab, the value of attribute Disallow Intentionally Adding.
This read-through attribute is readable and searchable but cannot be modified. For
existing customers who do not have an Intentionally Added flag in the Specifications
> Substances tab, the system assumes that it is set to No.

Exemption

There is an Exemption field on a declaration's <Parts/PGs> tabs. Exemptions are set in
a specification's General Info page; the values you see for Exemption on a
declaration's Parts tab are really coming from the associated specification.

For this reason, Declared Compliance is valid only if there is an associated
specification in the declaration. Only when there is a specification, and the spec has
exemptions associated (found in the spec's General Info), can you set Declared
Compliance to Exempt: when you do, you are then prompted to select an exemption
from the list.

Declared Compliance This field allows an information supplier to simply declare the
compliance state of the substance, either Compliant or Non-Compliant.

Threshold Mass PPM "PPM" means Parts Per Million. The Threshold Mass PPM value
comes from the Threshold Mass PPM for the corresponding substance in the
specification. If enabled, it can be used by the supplier to declare the mass at each level
of the BOS.

Declared PPM If enabled, can be used by the supplier to enter the PPM values directly;
can be used by the supplier to declare the mass at each level of the BOS. It supersedes
the Calculated PPM in the rest of the rollups.

Calculated PPM The PPM as the result of the division of the mass of two levels.
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Substance Editing

Substance editing lets you add, remove, and edit substances directly in (unpublished)
declarations. The substance editing feature is available on all types of declaration
except Supplier Declaration of Conformance and Part Declaration.

Linked to Composition Type Field, the declaration classes in which substance editing
works are as follows.

s Composition Type = Substance Composition:
— Substance, JGPSSI, and IPC 1752-1 declarations

s Composition Type = Homogeneous Material Composition:
- Homogeneous Material and IPC 1752-2 declarations

The behavior of the Actions are described according to the type of declaration.

Importing and Exporting Declarations

"Process extension" is the formal name of items in the Actions menu in declarations (in
standard Web Client) or links in the Actions column of declaration rows (in simplified
Web Client). Links in the Actions column enable you to perform an operation directly

without having to go open the declaration itself.

These are the current process extensions that may be available on declarations. The
Agile administrator at the buyer firm may have elected not to use more than the basic
Actions found on most Agile objects.

Process Extensions for JGPSSI Declarations

The following process extensions apply to JGPSSI declarations:

= Import JGPSSI - This process extension imports data from a text file in JGP Block
format for integration with the JGPSSI Excel template

= Export JGPSSI - This process extension exports data to a text file in JGP Block
format for integration with the JGPSSI Excel template

Note: It is possible that when you submit data to Agile from
Microsoft Excel, the data may not be successfully imported at the
buyer side. Yet you may have received a notification indicating that
transmission of the data was successful. The notification is triggered
by your submitting the data, not by its successful receipt: the
compliance manager may ask you to re-submit the data in these cases.

Process Extensions for Part, Substance, and Homogeneous Material Declarations

The following process extensions apply to Homogeneous Material Declarations, Part
Declarations, and Substance Declarations:

s Import AXML - "AXML" is Agile XML, an XML representation of Agile's business
schema that contains all product content managed in Agile. You use this process
extension to export the declaration information in aXML format. The declaration
can be completed and re-imported into PLM.

s Export AXML - A declaration that was exported using the aXML format and then
completed can be imported back into PLM using this process extension
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Process Extensions for IPC Declarations

The following process extensions apply to IPC declarations:

Import IPC XML - Imports XML data that is used to complete version 1.1 IPC
forms

Export IPC XML - Exports XML data that is used to complete version 1.1 IPC
forms

Import IPC 2.0 XML - Imports XML data that is used to complete version 2.0 IPC
forms

Export IPC 2.0 XML - Exports XML data that is used to complete version 2.0 IPC
forms

Exporting PG&C Data

Grouping the possible “export” process extensions:

Export JGPSSI exports the declaration in JGP Blocks format

Export AXML exports the declaration in aXML format; this can be used with Part
Declarations, Substance Declarations, and Homogeneous Material Declarations

Export IPC XML exports the declaration in XML format that is used to complete
version 1.1 IPC forms.

Export IPC 2.0 XML exports the declaration in XML format that is used to
complete version 2.0 IPC forms

Importing PG&C Data

Grouping the possible “import” process extensions:

Import JGPSSI imports a JGP Blocks file (if it was exported via Export JGPSSI)
back into the declaration

Import AXML imports an aXML file (if it was exported via Export AXML) back
into the declaration

Import IPC XML imports an XML file (if it was exported via Export IPC XML)
back into the declaration.

Import IPC 2.0 XML imports an XML file (if it was exported via Export IPC 2.0
XML) back into the declaration.

Importing and Exporting pre-version 2.0 IPC Declarations

This task outlines how you might receive an IPC 1752-1 or IPC 1752-2 declaration that
was created in Agile at the buyer site. You would complete the declaration working in
the IPC PDFE.

Note: This procedure only applies to the pre-2.0 version of IPC. For
IPC 1752A declarations, which were introduced with IPC version 2.0,
follow the procedure described in Importing and Exporting Version
2.0 IPC Declarations.

A typical RFI sequence with an IPC declaration:
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s The compliance manager at the buyer site creates an IPC declaration in Agile PLM;
this is an instance from one of Agile's IPC business classes, IPC 1752-1
Declarations or IPC 1752-2 Declarations. The default workflow for the declaration
is moved to the Open to Supplier status.

= You, the declaration recipient at the information supplier, log in to Web Client
(Basic mode) and see the declaration name. A link in the declaration row activates
the Export IPC XML process extension. (O, if you click the declaration name, all
available process extensions are displayed as links on the left navigation pane.) An
XML file is saved on your machine.

s If you have already downloaded the IPC PDF forms from the IPC web site
(http://www.ipc.org/ContentPage.aspx?pageid=Materials-Declaration), open
the IPC form in Adobe Acrobat and click Import Data (or File > Form Data >
Import Data to Form), then specify the location of the XML file. The
XML-contained data is imported to the PDF form.

= Enter or modify values in the declaration.

= When you have completed the form, the data is exported using Export Data (or
File > Form Data > Export Data from Form). The existing XML file is overwritten.

= Returning to Web Client, use Import IPC XML process extension to import the
modified XML data. Then submit the declaration to the buyer firm.

= At the buyer site, the compliance manager opens the completed declaration in
Agile to review for possible release.

Importing and Exporting Version 2.0 IPC Declarations

This task outlines how you can receive an IPC 1752A declaration that was created in
Agile at the buyer site.

Note: This procedure only applies to the 2.0 version of IPC. For IPC
1752-1and IPC 1752-2 declarations, which were introduced with IPC
versions prior to 2.0, follow the procedure described in Importing and
Exporting pre-v2.0 IPC Declarations.

A typical RFI sequence with an IPC declaration:

= The compliance manager at the buyer site creates an IPC declaration in Agile PLM;
this is an instance from one of Agile's IPC business classes, IPC 1752-1
Declarations or IPC 1752-2 Declarations. The default workflow for the declaration
is moved to the Open to Supplier status.

= You, the declaration recipient at the information supplier, log in to Web Client
(Basic mode) and see the declaration name. A link in the declaration row activates
the Export IPC XML process extension. (Or, if you click the declaration name, all
available process extensions are displayed as links on the left navigation pane.) An
XML file is saved on your machine.

= If you have already downloaded the Scribal750a_beta06 from the web site
(http://sourceforge.net/projects/ipcl75xutils/), open the IPC form in
Scriba and click File > Opendocument, then specify the location of the XML file.
The XML-contained data is imported to the Scriba form.

= Enter or modify values in the declaration.
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= When you have completed the form, the data is exported using File >
Savedocument. The existing XML file is overwritten.

= Returning to Web Client, use Import IPC 2.0 XML process extension to import the
modified XML data. Then submit the declaration to the buyer firm.

= At the buyer site, the compliance manager opens the completed declaration in
Agile to review for possible release.

Importing Substances to a Declaration with MS-Excel

When your company seeks compliance information about Parts/Part Groups by
sending a declaration to a supplier, it may not be convenient for the supplier firm to
compile that information directly into the declaration.

One option that is available to the Supplier is to export and import files in a format
called aXML. (For more information, see "Importing and Exporting Declarations” on
page 4-10.

A simpler solution is available in which compliance information that is sought by a
Declaration can be collected in a Microsoft Excel spreadsheet, then imported into the
Declaration. In this procedure, an Excel template is produced by PG&C.

These are the three main steps, covered in detail below:
»  Downloading the MS-Excel spreadsheet template;
» Adding substances to the spreadsheet template;

= Importing substances from the spreadsheet template.

Downloading the MS-Excel Template

A declaration has been created, and a specification has been added to it. Parts or
Manufacturer Parts or Part Groups are added to the declaration, whose objective is for
any substances of concern that are contained in these parts to be declared.

For this compliance information, the declaration may be sent to a supplier, or it may be
completed internally by a compliance manager.

To download the MS-Excel template:

s In the declaration, click the Actions drop-down menu, select Microsoft Excel >
Download Template.

s PG&C automatically exports the declaration's attribute information to the Excel
spreadsheet. The File Download dialog prompts you to Open or Save the file.

= To save the file, browse to a location on your hard drive. You can accept a
system-generated filename or enter a new filename.

»  Close the Get File dialog, which conducted the export of the spreadsheet file.

The importing process is continued in the next topic.

Adding Substances to the Spreadsheet

Download and save an MS-Excel spreadsheet.
To add substances to the spreadsheet:

1. The Excel spreadsheet must be populated with data about the substances being
declared for the parts named on the declaration.
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2. These are key fields that must be populated.

Important: The column headings must appear exactly as below. Two
columns, Parts.Rev/Mfr and Parts.Specification, must appear even if
they are not populated.

s CoverPage.Name
»  CoverPage.Declaration Type

»  CoverPage.Supplier - note that the Supplier name must be typed exactly as it
appears in PG&C

m Level - this number reflects the level in the Bill of Substances for the substance
in this row.

Important: Use the numerical sequence 0, 1, 2, 3 (not 1, 2, 3, 4). The
objects are in plural form, and “Homogeneous Materials” are called
"Materials" in the spreadsheet.

- 0 =Subparts

— 1 =Materials

— 2 =Substance Groups
— 3 =Substances

s Parts.Part Type - this and the next several fields could be for a Manufacturer
Part or Part Group

s Parts.Number

s Parts.Rev/Mifr - this column must be in the Excel file, even if there is no value
in any of this column's rows

»  Parts.Specification - this column must be in the Excel file, even if there is no
value in any of this column's rows

s Substances.Substance
s Substances.Mass
s Substances.Mass-Measure

= Substances.Substance Type - the Substance Type names must be plural, as
shown in “Level”, above

3. When you have completed populating the fields, save the spreadsheet file.

Importing Substances to the Declaration

Begin on the Cover Page of the declaration that was created for this process.

This part of the process may be completed by the supplier; or, the supplier may have
populated the Excel spreadsheet and sent it to the compliance manager, who can
complete the process, as follows.

To import substances from the spreadsheet:

1. In the declaration, click the Actions drop-down menu, select Microsoft Excel, then
select Import from Excel.
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2. Agile Import is opened. In the Import dialog, next to the Import File field, click the
Browse button.

3. In the Choose File dialog, select the Excel file that has been prepared with
Substances data in the previous topic, and click Open.

4. Inthe Import dialog, click Import.

Note: The Import process takes several minutes to complete. You
will know it has completed when the Close button appears.

5. Before closing the dialog, verify that the Import process has imported the
Parts/PGs and the Bill of Substances, which are viewed in the ACCEPTED
column.

6. In the declaration, click the Items, Manufacturer Parts, or Part Groups tab as
appropriate. The Substances table (below the list of the parts) lists the substances
that have been declared for each part/PG.

This completes the procedure for importing substances into a declaration with
MS-Excel.

Notes on Excel-based Declaration Submissions

When the supplier has used the Microsoft Excel-based Client to submit the
declaration, it is possible that data may not be successfully imported to the buyer side.
There are two stages in which their data is processed. The data is uploaded to the
server; upon successful upload, the supplier receives the message that “Your data has
been submitted for processing.” The data is then be processed on the server and
imported into the system.

If there was a problem with the upload, the supplier is notified immediately; but if the
problem occurs at processing or importing on the server side, the system sends an
email with the error log as an attachment to the supplier. This means that the
declaration remains in Open to Supplier status, and this does not change until the
supplier reviews the log in the email notification, makes appropriate changes, and
re-submits.

Even if the import on the server side is successful, depending on the size of the
declaration, it will take some time for the declaration to move from Open to Supplier
to Submitted to Compliance Manager. So if the user checked the declaration
immediately after submitting from Excel, they may not see the changes for awhile.

These “under the hood” behaviors are detailed so that you can instruct your suppliers.
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ACP
See Agile Configuration Propagation (ACP)

Affected Files

Similar to Affected Items, these objects are EC files that are Design Release Candidates.

Agile Configuration Propagation (ACP)
Propagating existing configuration the PLM to the newly installed version of PLM.

ACS
See Agile Content Service (ACS)

Agile Content Service (ACS)

ACS is an event-driven XML-based publishing service that makes the product record
available to a wide variety of business applications and users, internally and across the
global manufacturing network

Agile Destination

A package created by an Agile PLM system in the target PLM using Web Services to
import from the Attachments tab of the package in the target system.

Agile Integration Services (AIS)

A collection of predefined Web Services in the Agile Integration Framework that
enable communication between the Agile Application Server and disparate systems

Al
Affected Items tab on Change objects in Agile.

AIS
See Agile Integration Services (AIS).

Approved Manufacturer Parts List (AML)

List of approved manufacturer parts associated with an item.

AML
See Approved Manufacturer Parts List (AML).

API
See Application programming interface (API).
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Application programming interface (API)

A set of routines, protocols, and tools for building software applications. An API
expresses a software component in terms of its operations, inputs, outputs, and
underlying types.

Assembly

A product assembly lists the parts in a product and shows the substances and
materials that comprise those parts. It is linked to specifications that can restrict how
much of a particular substance that product assembly may contain

Audit

An audit is the pro-active process of verifying compliance with quality requirements.

Automated transfer orders (ATO)

Content published by Agile PLM users in real time with a content transfer order (CTO)
or set up subscribers to automatically create automated transfer orders (ATO) based on
a schedule or triggered by a workflow status change.

Bill of Material (BOM)

A hierarchical representation of a product that is made up of other products.

Bill of Substances (BOS)

A hierarchical list of substances that are contained in the parts and assemblies that
make up a BOM.

BOM

See Bill of Material (BOM).

BOS
See Bill of Substances (BOS).

CAD
See Computer-aided design (CAD)

Corrective and Preventive Actions (CAPA)

The CAPA is a formal process of addressing any generic quality problems and
analyzing the root cause so you can implement corrective and preventive actions.

Commodity

A class of goods that is in demand, that is supplied without qualitative differentiation
regardless of supplier.

Computer-aided design (CAD)

The use of computer systems to assist in the creation, modification, analysis, or
optimization of a design. CAD software is used to increase the productivity of the
designer, improve the quality of design, improve communications through
documentation, and to create a database for manufacturing. CAD output is often in the
form of electronic files for print, machining, or other manufacturing operations.

Contract (Price)

This is a subclass of the Published Prices class. Contract prices are prices provided by
the supplier for a specific item or manufacturer part. This price information applies
only for the specified duration and can apply to any project.



FTP

Co-Sourcing

The process of leveraging product cost across suppliers.

DCO
See Design Change Order (DCO)

Design Change Order (DCO)

A Change Order subclass that is available when the effected File Tab is enabled and
provides access to all Agile PLM Workflow functions.

Design File Folder

An EC file folder that is integrated with CAD and PLM files, providing full access to
PLM Workflow function.

EC

See Engineering Collaboration (EC)

EC Client

A Java-based Ul to access, administer and operated the EC solution.

ECO
See Engineering Change Order (ECO)

Engineering Change Order (ECO)

An object that carries with it all the proposed changes to a product and/or its BOM.
When approved and implemented, the proposed changes become effective.
Engineering Collaboration (EC)

An application that provides data and process integration between CAD applications
and Agile PLM. It allows CAD designers and engineers to capture and control the data
representing a primary source of the product record.

Extensible Markup Language (XML)

A markup language that defines a set of rules for encoding documents in a format that
is both human-readable and machine-readable

File Manager

The File Manager manages files in a repository or vault in the file system and provides
a place to store and retrieve files locally or remotely. You can install it on the same
server as the Agile Application Server or on a separate one. You can also install the File
in a redundant configuration and/or distributed across geographic regions.

File Transfer Protocol (FTP)

A standard network protocol used to transfer computer files from one host to another
host over a TCP-based network, such as the Internet.

FQPN

See Fully qualified path name (FQPN).

FTP
See File Transfer Protocol (FTP)
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Fully qualified file name

The exact name of a file on a computer that is completely specified such that it is
unambiguous and cannot be mistaken for any other file on that system.

Fully qualified path name (FQPN)

The full path of a resource, directory or file, stored in a computer. It is composed by the
full path to the resource and its syntax depends on the operating system.

Iltem Master

The product record. It is the entire collection of Items - Parts, Documents, and any
other user-defined subclasses of the Items class maintained under change control in
the Agile system.

Java Message Service (JMS)

The Java Message Service (JMS) APl is a Java Message Oriented Middleware (MOM)
API for sending messages between two or more clients.

JMS

See Java Message Service (JMS).

Lifecycle Phase

Current state in an object’s workflow.

LRR

Latest Released Rev - concerning a Part or Document.

Non-Conformance Report (NCR)

NCR reports a basic material deviation from specifications or requirements in one or
more products.

PDX

See Product Definition eXchange (PDX).

PG&C

Product Governance and Compliance is a solution designed to help manufacturers
manage all kinds of product compliance.

PLM

See Product Lifecycle Management (PLM).

Problem Report (PR)

A Problem Report contains a basic description of a generic quality incident, problem,
or incident reported from a customer's perspective

Product Definition eXchange (PDX)

A standard designed for the e-supply chain. This standard is based on the XML format
because it provides a simple yet powerful and flexible way to encode structured data
into a format that is both human- and computer-readable. In PLM, PDX packages
contain product content, such as items.

Product Lifecycle Management (PLM)

The process of taking parts/documents from inception to production to phase-out,
and all the stages in between.



RFI

Product Service Request (PSR)

Product Service Requests report quality incidents, and aggregate many PSRs to a
single PSR.

Protocol

A system of digital rules or agreed-upon format for data exchange within or between
devices. It determines the type of error checking and data compression used.
Published Price

This is a subclass of the Published Prices class. Published prices are prices provided by
the suppliers in response to an RFQ and published from the project. The published
price information can also be used in other projects.

PCO
See Price Change Order

Price

An object that carries with it all the proposed changes to a product and/or its BOM. It
can be approved and implemented to make the proposed changes effective.

Price Change Order

It is an object that carries with it all the proposed changes to a price. It can be approved
and implemented to make the proposed changes effective.

Quality Change Request (QCR)

QCRs allow you to aggregate problems into a routable quality record, perform
root-cause failure analysis, and drive the problems to closure using standard CAPA
procedures.

Quote History

A subclass of the Quote Histories class. Quote history prices are the stored prices from
supplier responses that you can use. Any change in the response line of an RFQ is
stored in the historical response and is usable at any time.

Request for Information (RFI)

A material declaration that lists the parts in a product assembly and shows the
substances and materials contained in the part.

Request for Quote (RFQ)

A standard business process whose purpose is to invite suppliers into a bidding
process to bid on specific products or services.

Request for Proposal (RFP)

A solicitation, often made through a bidding process, by an agency or company
interested in procuring a commodity, service or valuable asset, to potential suppliers.
Response Line

A response line has information about only one item. The negotiation of price and
terms for items is dealt with in a response line.

RFI

SeeRequest for Information (RFI).
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RFP
See Request for Proposal (RFP)

RFQ
See Request for Quote (RFQ)

RFQ Response

A medium of communication between the user and the supplier. One response from a
supplier can contain multiple response lines for different items. Price data is added to
the project automatically when the supplier submits the response.

Schema

In computer programming, a schema is the organization or structure for a database.
The activity of data modeling leads to a schema.

SDK

See Software Development Kit (SDK or "devkit")

Software Development Kit (SDK or "devkit")

A set of software development tools that allows the creation of applications for a
certain software package, software framework, hardware platform, computer system,
video game console, operating system, or similar development platform.

Sourcing Project

The entry point of sourcing and product pricing. A sourcing project tracks data
required for sourcing and pricing, to perform data analysis for effective pricing.
Supplier

A supplier of one or several commodities.

TLA
SeeTop Level Assembly (TLA)

Top Level Assembly (TLA)

The level in a BOM that indicates the ultimate product being manufactured.

Transfer Order

Every time Agile Content Service (ACS) publishes product content, it produces a
transfer order that keeps track of what, where, and when product content is
transferred.

UPK
See User Productivity Kit (UPK)

User Productivity Kit (UPK)

The Oracle online help system used in some Oracle products.

Web Service Extensions (WSX)

A Web service engine that enables communication between Agile Product Lifecycle
Management system and disparate internal and external systems.

WSX
See Web Service Extensions (WSX).



XML Schema

XML
See Extensible Markup Language (XML).

XML Schema

Description of a type of XML document, typically expressed in terms of constraints on
the structure and content of documents of that type, above and beyond the basic
syntactical constraints imposed by XML rules.
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